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Creating and Printing Reports
Case spreadsheets are the raw material that make up your CaseMap reports — many of 
which are required by the court. With a few mouse clicks, you can create professional reports 
instantly in Adobe® Acrobat, Microsoft® Word, or just printing them on paper. Using the Facts 
spreadsheet you can easily turn your fact chronology into Motions for Summary Judgment 
and produce the list of facts that you’re willing to stipulate for pre-trial motions. With CaseMap 
reports, What-You-See-is-What-You-Get, so what is displayed in your spreadsheet view is the 
same as what you see in your report. Make sure you have filtered your spreadsheet content 
and sorted records to create the view you want before printing your reports.

CaseMap also offers four pre-built reports that you can easily produce using a wizard to guide 
you through the steps. Pre-built reports include the following options: Privilege Log, Summary 
Judgment, By Issue Report, By Object Report.

1. Creating a Case
Before working in CaseMap, you first need to create a case file to  
store information regarding the matter.  

To create a new case:
1.	 On the File menu, click New.
2.	 Follow steps in the wizard to set up case information.
	 •  The time zone should reflect the primary location where your 	
	     case and most facts and events occur. 
	 •  Add case users later once the case is created and any custom 	
	     fields or views are added.
	 •  Save the case to a network folder so others can access it.
3.	 Click Finish to create the new case file and launch the new Case 	
	 Jumpstart Wizard.

2. Creating a Cast of Characters
CaseMap’s objects spreadsheets are used to organize your list 
of “nouns” and Cast of Characters regarding the case, including 
persons, places, events, documents, evidence, proceedings, and 
pleadings.

Short Names:
When names are entered, CaseMap automatically creates short 
names - unique names for each object entered in a case. Short 
names are what make linking case data possible. When a short name 
is identified, CaseMap automatically links the object to case informa-
tion: facts, issues, questions, and research. This feature is what allows 
you to search and view data in various ways so you can quickly locate 
essential information and create reports that shape and support 
your case strategy. For more information and tips on short names, 
see the CaseMap Answer Center.
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 To enter a basic Cast of Characters:
1.	 In the Case Jumpstart Wizard, click on the appropriate link to 		
	 type in your character name. The wizard provides pages for
	 Litigants, Judges, Opposing Counsel, Witnesses, Other People, 	
	 and Other Organizations.
2.	 When you’re done, click Finish. The All Objects spreadsheet 		
	 displays so you can review your Cast of Characters. Notice how 	
	 each object has a short name created for it.
3.	 In the Case Shortcuts pane, click the All Shortcuts bar to view 	
	 the Cast of Characters organized by sub-object spreadsheets.

3. Entering Issues
When you first create your case, start outlining your issues in the Issues 
spreadsheet so you can quickly develop a hierarchy of claims, counter-
claims, and any other known arguments. 
The Issues spreadsheet can hold as many levels or sub-issues as you 
want and is automatically numbered (1, 1.1, 1.1.1) to indicate main issues 
and sub-level items for a case.

To enter issues:
1.	 In the Case Shortcuts pane under Favorites, click on Issues.
2.	 In the Full Name field, type in an issue. 
	 CaseMap automatically creates a short name for the issue to 		
	 link issues to fact records and other case data.
3.	 Click the New Record button and then click Issues or press the 	
	 Insert key to enter in a new issue.
4.	 To create a sub-level issue, click the arrow                                   pointing to the 		
	 right. CaseMap automatically saves each record as you move to
	 a new field or record.

Creating and Setting Up a Case

To print to PDF:
1	 On the Reports menu, click Print or PDF 	
	 Current View. You can also click the 	
	 Print 	button on the CaseMap toolbar.
2	 On the submenu, click Print to PDF or 	
	 Print to PDF Email. The Print to PDF 	
	 Email option includes the PDF report in 	
	 an Outlook email that you can send to 	
	 case staff or clients.

To print to Word, Excel, TimeMap, 
NoteMap, HTML, or Corel WordPerfect:
1	 On the Reports menu, click Send
	 Current View To.
2	 On the submenu, click on the print option 	
	 you want.
	 Some options allow you to select either a 	
	 Grid or Record View. Try printing both to 	
	 see which view you prefer.

To print a CaseMap pre-built report:
1	 On the Reports menu, click the pre-built 	
	 report you want to print: Privilege Log, 	
	 Summary Judgment, By Issue Report, 	
	 By Object Report.
2	 When the report wizard launches, follow 	
	 the steps in each box.
3	 When you complete the wizard and the 	
	 report displays, you can save it as a Word 	
	 file to the network folder where you store 	
	 reports.

To print and view a ReportBook:
1	 On the Reports menu, click
	 ReportBooks.
2	 On the submenu, click the ReportBook 	
	 you want to print.
3	 On the print option submenu, click Print 	
	 to PDF or Print to PDF Email.
4	 In the Save As PDF dialog box, navigate 	
	 to the network folder where you save 	
	 reports, and then click Save.
5	 In the message box, click Yes or No to 
	 embed linked files. If you click Yes, select 	
	 which files you want to include in the 	
	 ReportBook, and then click OK.
6	 In the message box, click Yes to view the 	
	 ReportBook.
7	 In the Bookmarks pane, click on a
	 bookmark link to view that section of the
	 report.
8	 In the ReportBook PDF file, click the
	 paperclip icon in the lower left corner to 	
	 display embedded linked files.
9	 Double-click on a linked file to view it in its 	
	 native application.

Printing ReportBooks
ReportBooks are living documents that can be used throughout the life of the trial that are 
essential for ensuring that clients and case staff stay abreast of case developments and can 
readily collaborate in the case analysis process.

A ReportBook is a compilation of CaseMap reports packaged with optional elements such as a 
cover page, table of contents, confidentiality statement, introduction, and report-specific title 
pages. The layout is similar to the standard report generated when you print one of CaseMap’s 
spreadsheet views. CaseMap offers eight pre-built ReportBooks for you to choose from, 
including a complete Case Summary (as shown above) and an overview of What’s New in the 
Last 14 days.

ReportBooks are printed to a PDF file. You can choose whether to embed linked files in your 
ReportBook so that others can click on a document or file and view it in its native application.

Litigators use ReportBooks in a variety of ways:
•   Produce a ReportBook shortly after client intake to show clients that you have captured

  their concerns.
•   Compile a ReportBook to present your case to investigators, arbitrators, clients, and other 	
	  key decision makers.
•   Save your ReportBooks in PDF and link them to correspondence.
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Getting Data into CaseMap
CaseMap offers several ways to get case data into your case file.

 

    There are three main ways to get data into CaseMap:
    •  Manually entering data into spreadsheets
    •  Bulk importing data using the Import Linked Files Wizard    
    •  �Sending facts and data from other programs (like Microsoft® Word, 

Microsoft® Outlook, Concordance®, TextMap®, and Adobe® Acrobat).

A. Manually Entering Data
As you gather new case information, you can manually create a new 
record on any spreadsheet to update the case. To create new record, 
press the Insert key or click the New Record button on the CaseMap 
toolbar. Records are saved automatically as you navigate from record 
to record. To re-sort the spreadsheet, click Refresh Table on the
Records menu.

Need CaseMap Training? Visit us at LexisNexis University: http://www.lexisnexis.com/university/litigation-solutions. To access a free trial or 
purchase a DocManager subscription, contact your sales representative at 866-316-8525 or email sales@lexisnexis.com.

C. Using the Send to CaseMap Tool
You can easily send fact text or documents directly to your case from 
other programs. While building the chronology with facts linked to 
documents, you can enter fact details, link to case elements by using 
short names and issues, and mark the status of the new fact.

Steps for sending facts or documents are nearly identical for each 
product. For complete step-by-step instructions for all supported 
products, see the CaseMap Answer Center. 

To send a document from Adobe Acrobat or Reader:
1	 With your PDF file open, right-click in the document and click Send 	
	 PDF to CaseMap. 
2	 In the Send to CaseMap dialog box, select Document in the Object 	
	 Type list.

3	 �Type in the document name or edit the Full Name field, then click 
Save.

4	 In the Send to CaseMap dialog box, click Yes to view the new 		
	 document record in CaseMap.

	 Note: To send a fact, click the Send Fact to CaseMap in the PDF file.

To send facts and files from Word:
Send to CaseMap features display on a CaseMap ribbon within Word. 
The add-in is optional during CaseMap v10 installation.
1	 Open the CaseMap case that you want to import data into

	 from Word.
2	 In the Word document, highlight the information you want to 		
	 send, then click the Send to CaseMap - Add Fact button.

3	 When the Send to CaseMap utility launches, select the spreadsheet 	
	 you want and type in the document name, then click OK.
4	� In the Send to CaseMap – New Fact box, select Fact Text in the
	 Append Text Selection to field so that the excerpt displays in the 	
	 Facts spreadsheet.

	 Note: The text selected displays in the Text Selection field and is 	
	 enclosed in brackets. Do not delete the brackets. Removing them 	
	 prevents CaseMap’s recognition of short names and designate 	
	 actual document text for the import.

5	� In the Favorites Fields area, enter in additional fact record details 
like the date & time.

6	� Click the Issue Linker bar to link the record to an issue.
7	� Click OK to initiate the import process.
8	� In the message prompt, click Yes to view the new fact record in the 

Facts spreadsheet.
9	� Click in the Fact Text field to view the highlighted text you sent from 

the Word document.
10	�Click on the paperclip icon for the fact record to view the linked file 

path and open the file in Word.
11	� Scroll to the right and notice that the Source(s) field displays the 

linked element to the Word document and that the Linked Issue 
field displays any issues added for this record.

12	� Click on the Documents spreadsheet to view the record created 
for the linked Word file. If you only want to send the Word

	 document, click the Send to CaseMap – Add Object button.

Case Analysis
Analyzing case data tells you what you already know and points the way to important information that you may need to know more about. Searching, 
sorting, tagging, and filtering case information from various angles may offer insights not otherwise noticed.

A. Analyzing Spreadsheet Records
After getting data into Casemap, you’ll want 
to analyze spreadsheet records and com-
plete information in each field. For example, 
on the Facts spreadsheet, you’ll want to mark 
which facts are relevant (Material field) and 
whether the facts are disputed (Status field).

B. Sorting Fields
Sorting determines the order case elements display in a spreadsheet view, allowing you to review 
information in various ways to determine what items need to be addressed first or categorized 
based on the status of items. To sort a field, right-click on the field header (title), and then click Sort 
Ascending or Sort Descending. To sort multiple fields, click the Advanced Sort button and enter the 
fields you want to sort.
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C. Filtering Spreadsheet Records
Filtering allows you to cull data for reports or save filters to rerun later 
when additional information is added to the case. Records that meet 
the criterion of your filter remain in view on the current spreadsheet; 
while other records are temporarily hidden from view. You can filter by 
key words, field status setting, or create multi-level filters (key word + 
field status). You can also run pre-built filters from the Records menu, 
by clicking Filters and selecting an option from the submenu. The filter 
menu options change depending on the spreadsheet you are viewing.
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E. Viewing Documents and Images in DocManager
Content analysis can be done in CaseMap’s DocManager near native image viewer. DocManager allows you to review and annotate documents 
and images without having to open the source file in its native application. You can add notes to annotations, edit annotations and notes, and also 
search annotation notes. Annotation colors can be changed by each user, but only one color is used for printing. When a search is run, search hits are 
highlighted in DocManager allowing you to review content and navigate between search hits. Current search hits are highlighted in blue. All other 
search hits are highlighted in yellow. You can then view and print the Linked File Text Hits and Review Linked File Hits reports. You can batch print 
linked document files with or without Bates stamps and choose whether to include annotations and notes in the printed output.

 B. Importing Documents and Files into a Case
The Import Linked Files Wizard guides you through importing one or 
more documents/files into your case. The wizard will create a new 
record for each document you select to import. After the import, Case-
Map indexes all new file content. You can begin searching the updated 
case data as soon as the index process completes.

To bulk import documents:
1	� On the File menu, click Import and then click Linked Files from a 

Folder.
2	 In the Import Linked Files Wizard, click Next.
3	� In the Select Files to Import dialog box, click one of the import
	 options: Add Files or Add Folder.
4	� In the Select Files to Import dialog box, navigate to the folder 

where the files are saved, and select the file or folder to import, and 
then click Open. The files now display in the Selected files box. 

5	� After reviewing the files, click Next.
6	� �In the Spreadsheet drop-down list, click the spreadsheet for which 

you want to import the files, and then click Next.
7	� In the Ready to Import dialog box, review the files and spreadsheet 

you selected for the import.
8	� Click Next to initiate the import process.
9	 In the Completing the Import Linked Files Wizard dialog 
         box, review the number of files imported, then click Finish. 
         The new records display in the selected spreadsheet.
10	In the Completing the Import Linked Files Wizard dialog 
         box, review the number of files imported, then click Finish. 
         The new records display in the selected spreadsheet.
11	 In the Case Shortcuts pane, click on the spreadsheet.
	 A paperclip icon displays next to each record to indicate 	 	
	 that a linked file is attached.
12	 Click on the paperclip icon to view the file in its native
	 application or in the DocManager viewer.

The Web-based CaseMap Answer Center brings together helpful topics and useful information.  It’s all just a click away.
On the CaseMap Help menu, click Contents to launch the CaseMap Answer Center.

The Search Results navigation pane has four parts:
Search field — Allows you to type in full-text search terms.
Narrow Results panel — Allows you to view search hits found in spreadsheet 
fields, linked file text, or annotation note text. The number of search hits 
found displays to the right of the results.

To view a document or image file:
In a spreadsheet, click on the paperclip icon for the linked file you want to view. To view
multiple documents at one time, click the Pin icon in the upper right corner to this position.

To navigate search hits:
Click the Previous Hit and Next Hit buttons in the lower left corner of DocManager. You can 
also click on or type a number in the Page list to jump to that page.

To annotate documents or images:
1.   Open a linked file in DocManager and click the Annotation mode button.
2.  	Click Annotate Text. You can also click the Tools menu and then click the first menu item 	
	 on the shortcut menu, and click Annotate Text.
3.  	Drag your mouse pointer over the text you want to annotate to open the New Annotation 	
	 dialog box. The text you selected now displays in the Document Text box.
4.  	In the Note tab, type in information you want and then click OK.
	 Tip: If the selected text is worthy of a new fact record, click the Create New fact button to 	
	 add it to the Facts spreadsheet.

Results panel — Displays all spreadsheets that contain records or linked files 
with search hits. The number of search hits found displays to the right of the 
spreadsheet name.
Resources panel — Provides access to three search results reports.

D. Searching Case Data
CaseMap allows you to quickly search case data because of the comprehensive index created 
during the import process. You can search and locate all instances or “hits” of your search terms in 
spreadsheet records, linked files, and annotation notes.

Search terms can be more than one word. They can also be numbers, text phrases, or a combined 
use of terms and search operators. To run a previous search or search by selected spreadsheets, 
click the Records menu and then click Full Text Search.

After a search is run, search results display in two areas in CaseMap: the Search Results pane and 
the spreadsheets pane. Print the Search ReportBook to create a report of each spreadsheet 
record and all linked files located based on your search query.


